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Chapter 1

Kickstarting the Editorial
Process

elcome to the bright yellow world of For Dummies books! As a Dummies
author, you’re the readers’ expert guide to a new topic they’re just
beginning to explore.

One of the first big questions new authors ask is how does a Dummies book “hap-
pen”? After all, we typically hire authors for their topic expertise and not their
deep insider knowledge of publishing. Even if you’ve worked with other publish-
ers or other Wiley series in the past, it doesn’t hurt to know the quirks of the
Dummies way of doing things. This chapter explains what you need to know about
navigating the editorial process when writing a Dummies book.

Meeting Your Editorial Team

After you sign your contract, you eventually get a whole team assigned to help you
as you write the manuscript for your book. You may not meet your editorial team
in person, but you likely will get to know each other by email, over the phone, and
through the queries and edits that appear in your chapters.
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The following list explains each person’s role in the editorial process:

3 The acquisitions editor (AE) is your main contact through the contracting
process, including setting the initial schedule. During the manuscript writing
process, you'll likely hear less from your AE. Once your book is published, the
AE serves as your main contact for any questions you have about promotions
or marketing.

3 The Dummies coach helps you get up to speed at the beginning of the writing
process. She works with you to develop a strong Table of Contents and then
gives you feedback on your sample chapter so you know what you're doing
well and what you need to work on. With this foundation, you can be confident
that you're on the right track when you start writing chapters for real.

3 The managing editor (ME) is your uber-project manager after the project is
contracted and launched. The ME keeps an eye on the big-picture stuff,
ensuring that the project is moving smoothly from the writing stage all the
way through to publication. You'll hear from the ME only occasionally but can
contact her anytime you need information on the overarching process.

3 The project manager (PM) is your day-to-day contact through the writing
process. The PM receives your submissions and handles any questions about
the content of your book and editorial process as it relates to the writing.

3 The development editor (DE) reviews the overall organization of your book
and each chapter and suggests changes as needed. He may suggest content
to add or delete, or edit the way you've used For Dummies chapter elements.

3 The copy editor (CE) does the line-by-line editing for sentence structure, flow,
and For Dummies style. The CE also helps to establish conventions, which
standardize the way terms specific to your book are spelled, capitalized, or
formatted.

3 The technical editor (TE) is a subject matter expert on the topic of your book
who checks the facts, steps, and figures in your book for accuracy. He might
also provide insight to your DE on ways you can improve your content by
recommending alternate or additional content. The TE gets credit on the
book’s Editorial Acknowledgments page and receives compensation for his
work from Wiley. Your AE or PM may ask whether you have recommendations
for a TE. After a TE joins the project team, the PM routes chapters to and from
the TE.

It’s common for a single editor to take on the project management, development
editor, and copy editor roles for a single project. For convenience sake, we often
refer to these superstar editors as project managers (PM). For the purposes of this
TIP book, you’ll see the terms PM, DE, and CE to indicate the specific roles. Don’t be
shocked, however, if you work with a single editor who handles all three roles.

PART 1 Getting Started on Writing a Dummies Book



TERMS THAT WILEY EDITORS AND
PUBLISHERS USE

Like any field, publishing has its own lingo. Wiley even has a few terms unique to our
organization. In addition to the abbreviations for the different roles, like DE and CE, the
following terms are also helpful to know:

® AR: Author review. This is your chance to review the edited manuscript; address
any queries from the DE, CE, or TE; and make sure no errors were introduced dur-
ing the editing process. It typically takes 4-6 weeks after you submit 100% of your
manuscript to complete AR.

® BBD: Bound book date, or the date when your book rolls off the printing presses.

® CRD: Consolidated release date, a unique-to-Wiley term referring to the day your
book officially ships from our warehouse to resellers. The CRD is typically the first
Monday after BBD.

® Launch: The launch refers to when your AE officially hands the project to an ME
and PM to manage. At this point your ME becomes your uber-project/process
resource, and your PM becomes your main day-to-day point of contact for all mat-
ters pertaining to your manuscript.

® PFRD: Project first receipt date, the date that the product is received in the
warehouse.

® Pub Date: Short for publication date, this date points to when your book should
have widespread distribution to online and bricks-and-mortar retailers. This date
falls 2 weeks after CRD, but don't be shocked if your book is available a bit sooner
or later.

® Operations: The team of people who lay out the book, process and place the
graphics, manage the proofreading and permissions checking, and ship the book to
the printer. We often informally refer to these folks as “production.”

® In-store date: The date we expect book fully available in all retail outlets. When
Amazon talks about a release date, that's the in-store date.

® TOC: Table of Contents, or the outline for what you plan to cover and where you
plan to cover it. In Dummies, the TOC has two parts.

® TOCG: TOC at a Glance. This standard Dummies element includes the highest TOC
elements: the parts and chapters.

® Full TOC: This is the fully blown-out TOC that includes all the level 1 and level 2
headings within each chapter.
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Summarizing the Editorial Process

The Dummies editorial process has evolved over the 30 years since the first book
in the series published in 1991. The well-honed process is a big reason why we can
successfully publish hundreds of titles every year. In the simplest terms, the edi-
torial process looks something like this:

1. Develop a TOC and draft a first chapter.

2. Write and submit chapters to your PM.

We provide a Microsoft Word template for use in properly formatting your
chapters for layout, as well as guidelines for formatting and submitting the art
for your book.

3. Respond to editorial and technical review comments and queries in
Author Review.

This step typically occurs after you've submitted 100 percent of your manu-
script and usually requires an additional 4-6 weeks of work to complete.

4. Reviewand provide feedback for your book’s cover.

n

Provide input during the production and proofreading process as
requested.

Your PM may ask for your assistance after layout if there is a page-count issue
or offer you an opportunity to review proof pages to confirm figures or
equations are placed correctly.

Starting at the Very Beginning with a Table
of Contents and Sample Chapter

There’s reason to celebrate after the digital ink is dry on your contract. You have
now joined an illustrious club of experts, educators, and even celebrities who’ve
given life to the Dummies brand for three decades. Of course, there’s a lot of work
ahead to turn all your expertise into the latest Dummies book.

Before you get the green light to start writing and submitting chapters to your PM,
you need to develop a solid Dummies-style Table of Contents (TOC) and possibly
draft a sample chapter as well. This process assures you have a basic understand-
ing of how to use the elements of a Dummies book in your writing.
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Creating a TOC the For Dummies way

Your first big step after contracting is creating or refining your Table of Contents
(TOC). The TOC is the heart of your book. It outlines all the book elements that
you’ll include and how you’ll organize them, following the accessible and modular
style of the For Dummies series. A detailed and well-organized TOC makes the
writing and editing process much easier.

This section explains the essential elements of a Dummies TOC — and all the rea-
sons a good TOC is essential.

Identifying your audience

For Dummies books help people who know nothing or very little about a topic get
started with that topic. Also, Dummies readers aren’t dumb. They just need to get
up to speed quickly and easily, and as the author, you’re their guide.

One common tip we share with authors is to write the TOC, and later the manu-
script, as if you were writing for one specific person. Think of the person who
would benefit the most from reading the book. Sometimes that person is real — a
friend or a family member. Other times it might be a persona made up of what you
imagine the reader knows and doesn’t know. If you can meet the needs of this
target person, you likely will be meeting the needs of a larger audience.

If you’re unsure what audience assumptions are safe to make, discuss your
thoughts with your AE.

Starting is the hardest part

For many new authors, nothing is harder than putting together the first elements
of a TOC. How do you start outlining your book? Here are a few exercises that can
help you begin transforming your subject-matter expertise into a full-fledged For
Dummies TOC:

¥ Brainstorm a list of tasks you associate with the subject matter.
¥ List the things a beginner to your topic might want to do or understand.

¥ For each of those things, list the skills a beginner needs to know to grasp the
topic. If a beginner needs to understand any concepts, list those, too.

For example, if you’re writing about running a restaurant, tasks might include
finding a space, creating a menu, following health codes and laws, hiring staff,
bookkeeping, developing marketing and social media plans, refining customer
service, and so on. From there, you might list the basics that a reader needs to
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understand for each of those tasks. For example, when choosing a space, a begin-
ner may need help figuring out how much space they need and all the factors they
should consider when transforming the space they want to use into a profitable
restaurant.

Emphasizing sequences, tasks, and results

The TOC is not only a navigation tool that helps readers find information, but also
a sales tool. Before readers decide to buy a book, they flip through the TOC, espe-
cially when buying a book online.

As your potential readers skim the TOC, you want them to learn something basic
about what your book will enable them to do. Here are tips to help you make that
happen:

3 Organize your parts and chapters around the sequence readers follow to
get started with the topic and progress toward greater understanding.

3 Write part titles, chapter titles, and headings that are action or task
oriented and convey the results readers will achieve. To keep the
presentation action or task oriented, use gerunds, such as creating, estimating,
or formatting, and make those gerunds as specific as possible. (Working with
and understanding are often vague.)

3 Use subheadings to break things down, as long as they relate to the main
heading. You should have roughly one heading per page. If you estimate the
chapter will be 20 pages, include 20 headings/subheadings. See the upcoming
section, “Adding the final touches,” for details about estimating page counts in
the TOC-development phase.

3 Avoid asking questions of the reader in the TOC. Readers have the
questions and are looking to you for the answers.

Ask your AE to recommend or provide the TOCs from other For Dummies books that
you can use as good examples for your topic as well as the depth and detail your
TOC needs to achieve.

Organizing the parts and chapters

A standard For Dummies book is organized into four to six parts, and each part
needs to contain at least two chapters. Here’s how the parts and chapters are gen-
erally organized:

¥ Part 1 covers the foundational information readers need to accomplish their
goals with the book’s subject matter. Any chapters in Part 1 should relate in
some way to the rest of the book. In a personal finance book, Part 1 might
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cover basic financial literacy. In a graphics software book, Part 1 might include
an introduction to a software program'’s interface and technical concepts that
readers need to understand to use the software.

¥ The middle parts cover different aspects of the topic in enough depth for a
novice to accomplish her goals. The personal finance book might have parts
that cover saving, investing, and insurance. The graphics software book might
have parts about editing photos, drawing, and sharing prints or digital images.

¥ The last partin all For Dummies books is the Part of Tens, which has at least
two chapters that are top-ten lists or resources, examples, case studies, tips
for success, or whatever seems most appropriate for your topic and audience.

If your book has two or more appendixes, those can appear in a part after the Part
of Tens.

Adding the final touches

To function as the road map for your book, the TOC also needs to include the
following:

3 Introduction: The format for the book’s Introduction is the same throughout
the For Dummies series. At the TOC stage, your AE will advise you on the
headings that will appear in the Intro and the number of pages you should
allocate for the Intro. Later, your PM will send you a template to follow as you
write the Introduction.

3 Cheat Sheet: Start thinking about what you'd like to include. At the beginning
of your TOC, you can create a Cheat Sheet section and list the ideas you have
for this element.

3 Page count estimates for each chapter and book element: The goal is to
start thinking strategically about how you'll use the allotted pages in your
book.

Your AE has established an overarching page-count estimate for the book. If you
haven’t received this info yet, be sure to ask so you know how much publishing
real estate you have to work with.

The following process can help you approximate how many pages to allocate for
each book element:
1. Figure out how many pages you need for the standard elements.

These include the Introduction (typically four to six pages), the TOC and other
front matter (3 percent of total page count), the index and other back matter (5
percent of total page count), and the parts pages (two pages each).
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Subtract that number from the target page count, provided by your AE.

3. Divide the remaining pages among the chapters and appendixes (if you
have them).

Page-count estimates for chapters should be even numbered.

Table 1-1 provides an example based on a 384-page book.

TABLE 1-1 Estimating Page Counts in the TOC
Front matter and Table of Contents 12 pages
Introduction 4 pages
Parts pages (five Parts, two pages per Part) 10 pages
Chapters 338 pages
Back matter (index, about the author, dedication, 20 pages

acknowledgments)

Cheat Sheet Online element. No pages used.

ESTIMATING PAGE COUNT FOR A CHAPTER

No one expects you to have 100 percent accurate estimates of the book’s page count
in your TOC. You do, however, need to have a general idea of how many pages you're
writing. You don’t want to estimate 20 pages for a chapter but find that you've written
30 pages and now you suddenly need to cut 10 pages somewhere else.

To gauge the approximate length of a chapter, make sure you have the template mar-
gins and page borders applied, as discussed in “Setting the margins.” Add the number
of pages you've written and the space needed for each figure, which are roughly one-
third of a page. For example, 14 text pages + 3 figures = about 15 total pages, which
rounds up to 16 pages in a For Dummies book (because all elements have an even num-
ber of pages).

If you're writing a Dummies book for the first time, you'll write a draft of a single chapter
as part of the onboarding and training program. This will help you see how many pages
you need to get each idea on paper. Use that chapter to gauge what you think you'll
need to write for additional chapters.
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Estimating page counts for each chapter is tricky, especially if you’re writing your
first Dummies book. You’ll likely need to revisit your initial estimates after you’ve
written the first chapter and have a better idea how many pages an average chap-
ter requires.

Getting TOC approval

Submit the TOC to your AE by the date set in your contract or agreed to via email.
Your AE, the Dummies coach, or your PM (or all three!) will review and provide
feedback at different points early in the process to help you better achieve Dum-
mies style and organization. On rare occasions an author might also get early
feedback from a TE who will help you refine topic coverage and remember items
you may have overlooked. It’s not uncommon for a TOC for a new book to go
through three to four rounds of review before considered to be approved.

After the TOC is approved, it becomes a road map for you and the publishing team.
Here are all the ways in which the TOC is used during the editorial process:

3 As a writing tool: You follow the outline as you write the book. You can make
small adjustments to the TOC as you write. If you want to make TOC changes
after the TOC is considered final, talk to your PM or DE.

3 Project management: Your PM, DE, and CE use the TOC to track all the
elements, keep the book organized, identify where to add cross-references,
and much more.

3 Book cover: The copy writer, who drafts the book’s descriptive online copy
and cover copy, refers to the TOC to make sure the book description and
cover accurately reflect the book’s content.

A Table of Contents is a living document that isn’t considered “final” until the
book publishes. We fully expect you to make changes, refinements, additions,
edits, and other alterations as you write the chapters. Be sure to leave an Author
Query note for your PM when you make TOC changes so he can make note of the
updates in the project tracking tools.

Creating a sample chapter

We don’t expect any author new to the Dummies series to have deep understand-
ing of all the nuances and guidelines of our editorial style. We use the sample
chapter review process to help you gain an understanding of the basics so you can
create chapter drafts ready to be edited.
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We ask all new Dummies authors for a sample chapter before we launch a book
project, but we might also ask experienced authors for a sample as well. Such
requests typically occur if the author has not recently written a Dummies book, is
collaborating with a new co-author, or is writing content for a new or offshoot
brand extension.

Confer with your AE on which chapter they’d like you to write as a sample. We
recommend selecting a chapter in one of the middle parts. These chapters are
typically more hands-on and thus easier to write than earlier chapters, which
tend to be more conceptual or high-level. In addition to being easier to write, a
hands-on chapter typically offers opportunities to include the chapter elements
you’ll use most often and receive feedback on how you’re using them.

Now is the time to buy or subscribe to Microsoft Word. Other writing and word
processing applications, such as Google Docs and Pages, have features like Word,
but those programs are never wholly compatible with the template we require you
to use in your writing. Using Word is required. It will help you avoid an abundance
of formatting issues.

Here are a few tips for writing your sample chapter:

3 Start with a blank Word document and attach the appropriate template.
Using the template from the get-go is the easiest way to format the chapter.
See the section “Formatting with the Template” for instructions on applying
the template.

3 Do your best to apply formatting. After you attach the template, macros
appear that help you apply the formatting. If you have questions about
formatting, the Dummies coach or your AE can help you as part of the sample
chapter feedback process. See the section titled “Formatting with the
Template” at the end of this chapter for instructions on applying and using the
Dummies Word template.

3 Follow your TOC. If staring at a blank screen is intimidating, copy the chapter
outline from the TOC document, paste that into your chapter file, format the
headings, and then write, write, write to support those topics.

3 Use the For Dummies chapter elements to break content into chunks and
make it accessible. For example, use headings to break up long sections. Use
bulleted lists to present lists of tips or related ideas. Use numbered lists to
break sequences into steps. Use icons to make essential or helpful informa-
tion stand out. Chapter 2 explains the available chapter elements and how to
format them.
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FIGURE 1-1:
Edited chapters
will include edits,
highlights, and
comments from
your editors.

TIP

New authors should expect to go through at least two or three rounds of feedback
and revision on the sample chapter. Your first round of feedback will likely include
so many revision marks and comments that you’ll have a hard time finding where
your original chapter exists. Don’t panic when you see this level of editing. It’s
very normal to get a lot of feedback the first time your AE, the Dummies coach, or
your PM reviews your chapter. See Figures 1-1 and 1-2 for examples of how a
chapter looks after it’s been edited.

1 Figuring out wWho _to invite2Y

Itsimply isn’t feasible te-ilnviteing everya—<ery member of your extended
family to a reunion simply isn’t feasible @md- unless you havesare a very tiny
family. If you consider hew-many-the number of people are-in your family
(including yourself, your parents. and your spouse), the guest list will-can be
overwhelming. So: v¥ou'll may need to do some paring.{

Thiere’s a simple trick to-for formulating a guest list for a reunion: Ceompile
the guest list based on a common or unifying factor. Having a Deing seThis
witbcommon factor makes the reunion more enjoyable-fereveryone because
everyone will-sharesyeuH-all-have something veryspecialineommen.|

<Remember>

b2 for the guest list. For instance, you can gathcr al] the children,
graudchlldren and gr cat- -grandchildren of a couple celebrating atheir
milestone wedding anniversary. This kind of gathering lets far-flung relatives
reunite while it helpires the parents and/or grandparents celebrate a very
special day.q

Cheryl: Clarifications okay fo the first sentence? Thanks, Maryq

Another nifty guest-list idea is to gather all-of the descendents of the first
relative te—that arrived in the “new co-.mtry - This group can be quite-= large
3 . However, this idea His &
great idea-for families who are curious about their origins, and this interest is
passeds on to the younger generations in the reunion process. In Chapters 13
through 16Past: I will-discuss some fan-cnjoyable ways to get everyone

involved in the family research
relativests 5. This research includes fun-entertaining activities, such as
sharing famiIv stories, photos, the family tree, and amint-museum’ of

kpecial memorabilia.q

New authors tend to overlook many of the smaller details of a Dummies chapter
in their first sample chapter draft. Impress your AE, the Dummies coach, and the
PM by remembering to include elements like the Chapter Number, Chapter Title,
In This Chapter heading and bullets, icons, figure captions, and sidebars. You can
find insight into what each of these elements are and how to use them in
Chapter 3.
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Cheryl: Changed heading to be more descriptive of what’s in this section.

Locating everyone9

Sometimes, finding the clan can make the reunion planner (you) feel like a
gumshoe in a detective movie. Folks move or disappear from the family
Christmas-holiday card list without a trace.q

In Cehapter 2.t 121 tell you how you can find thefelksyour kinfolk, and I
give you some great advice on where to look. Put on your overcoat, grab a
pencil, and enjoy the hunt.§

Pondering the time and locationWhen-and
Wherey

Edits okay? Thanks, ag.|

FIGURE 1-2:
Dummies editors
edit heavily for
content, clarity,
and style.

reunion-will-be-based-on-the size-of the guest list. RememberNote:; tThe
larger the group, the more planning the reunion-will requires. ['"Well discuss
the nitty-gritty of planning guidelines in Cehapter 4.9

When to plan the reunion can be tough. Most family reunions take place
during the summer, meaths—This-which makes it easier for families with kids
te-arrange-to-attend-and usually means that the weather will be-cooperateive.
However, if you live in the Pacific Northwest like I do, the weather is hit-or-

with the-elaa family?)

Planning the art

Most For Dummies books include photos, line art, screen shots, or other art. Illus-
trations and photos must work with the text, providing support for the points you
make and offering further explanation where words alone cannot.

The art-planning process differs depending on who supplies the art:

3 If you're providing the art for the book (most authors do), making sure that

»

your art meets Wiley's graphics specifications is an important upfront task.
You also need to make sure you have the appropriate legal permission to
use the art.

If you are not providing the art for the book, make sure your AE, ME, and
PM understand who is providing it, and together, create a plan for what art is
needed and how the art will be created. For example, you might provide
drawings or source material that production uses to create line art.

To get a full understanding of what’s involved in including art in the book, check
out Chapter 4.
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If you’ll need to include math equations, geometric figures, or molecular struc-
tures in the book, address this with your AE or PM — unless they beat you to it.
There are basic best practices for supplying this type of artwork, and we want to
test samples of these figures before you get into the swing of writing.

Formatting with the Template

TIP

The Dummies Word template is one of the more mystifying pieces of the Dummies
editorial toolbox for new authors. The template bypasses the built-in shortcuts
Word provides for creating bulleted or numbered lists and other elements, replac-
ing the one-click formatting with a seemingly odd pattern of tabs and spaces. At
its most vile, formatting can feel like a time suck that derails your train of thought
while you go back to figure out how to style a chapter title one more time.

The good news is we don’t expect you to be a formatting whiz. We don’t want
formatting to distract you from writing clear, well-structured chapters. Your PM
or DE is usually more than happy to help format your chapter properly as long as
you’ve applied the template and styled the major chapter elements. Doing so helps
your editor understand what element you want. The major elements include the
following:

3 Regular paragraphs (Normal style)
¥ Headings 1,2,and 3
¥ Figure captions

¥ Bulleted and numbered lists

Like most of the quirks of the Dummies process, the template is the way it is for a
reason. The template contains styles for formatting the different chapter ele-
ments. The template also has macro buttons that apply the correct margins and
page borders to your Word document. With the margins, page borders, and styles
correctly applied to your chapter document, you will see a close estimate of how
much content you’ve written, which can help you stay within your target page
count. Down the road, the template also simplifies the process of turning your
Word documents into actual Dummies pages.

Please do not adjust the attributes of the formatting styles or create your own

styles. Also, please do not include headers or footers in your files (such as running
heads for chapter titles or footnotes for page numbers).
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The following sections walk you through the process of setting up Word to work
with the template, applying the template, and setting the margins. Chapter 3 has
details about formatting specific chapter elements.

Saving the template to your hard drive

To use the template, you must first save it to your computer’s hard drive. Follow
these steps to do so:

1. Copy the template to your Desktop.

Please do not rename the template.

2. You're done!

Beginning a new chapter

If you're starting a brand-new chapter, simply double-click on the template file
on your desktop, and a new document appears with the template attached. You’ll
see boilerplate text for the chapter number, chapter title, and so on. Make sure to
rename the file right away (choose names like WritingFD Cho1, WritingFD Cho2,
and so on) so you don’t overwrite the template file.

Applying the template to a document

To attach the template in Word for Microsoft Windows, you first need to display
the Developer tab. See the nearby sidebar for details.

Your AE will ask the Dummies coach, your ME, or your PM to send you the Word
template for your book. After you save the template file to your hard drive, you can
apply the template to a Word document.

Be sure to attach the template to an existing or new Word document. Don’t simply
open the template (. dot or .dotm) file and begin writing directly in it. That causes
problems later in the process.

WARNING
To apply the template, follow these steps:
1 . InWord for Microsoft Windows, click the Developer tab and then click

Document Template. In Word for Mac OS X, choose Tools => Templates
and Add-Ins.

The Templates and Add-Ins dialog box appears.
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2. Click the Attach button.
The Attach Template dialog box appears.

3. Navigate to the location on your hard drive where the template file is
saved. Select the template and then click the Open button.

4. Backinthe Templates and Add-Ins dialog box, select the Automatically
Update Document Styles check box, as shown in Figure 1-3.

5. click ok.

Templates and Add-ins ? x>
Templates XML Schema XML Expansion Packs Linked €55

Document template

ChUsersyvadang2\AppData) ing\Microsofty I \DUMReg Temp 082713_wdz2010 attach...

] swtomaticall update document styles?

Attach to all new e-mail messages
Global templates and add-ins

Checked items are currently loaded,

CleanupTools2007.dotm . Add...
[ ] attachsp2007.dotm

FIGURE 1-3: Full path: 4. \AppData\Roaming\MicrosoftyWord\STARTUR CleanupTools2007.dotm
Attach the Word

template in the
Templates and

Add-Ins Organizer... Cancel
dialog box.
If you want to see these steps in action, check out this 48-second video: https://
youtu.be/JkXbntpAYsU.
TIP

With the template applied, macros for applying the margins, page borders, and
styles appear. If you don’t see the macros available after you’ve tried to attach the
template, try choosing View = Toolbars and choosing the toolbar for the template.
In the standard Dummies template, look for the Dummies Styles toolbar; in the
Dummies Portable template, it’s the Portable toolbar. If the view settings don’t
display the toolbar, contact your PM for help.
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THE DEVELOPER TAB'S BIG REVEAL

You have to tell Microsoft Word for Windows to show the Developer tab on the Ribbon
only once. After that, the tab appears any time you open Word. To reveal the Developer
tab, follow these steps:

1. Choose File = Options.

The Word Options dialog box appears.

2. Select Customize Ribbon in the sidebar on the left, as shown in the following
figure.

3. From the Customize the Ribbon drop-down list, make sure Main Tabs is
selected.

4. In the list box, select the Developer check box.

5. Click OK.
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REMEMBER

Turning off automatic formatting

For the template to work properly, you need to turn off most of Word’s automatic
formatting — especially bulleted and numbered list formatting. In Microsoft
Word for Windows you turn off the automatic formatting by following these steps
(which may vary slightly depending on the version of Word you’re running — if
you have questions, ask your PM):

1.

N

Choose File > Options.

The Word Options dialog box appears.

Select Proofing on the left and click the AutoCorrect Options button.
On the AutoFormat As You Type tab, clear most of the check boxes.

You can keep the Straight Quotes with Smart Quotes option; the Internet and
Network Paths with Hyperlinks option; and Hyphens (--) with Dash (—) option
selected.

On the AutoFormat tab, clear most of the check boxes in the Apply and
Replace areas.

Again, you can keep the smart quote, hyperlink, and hyphen/dash options
selected.

In Microsoft Word for Mac OS X, follow these steps:

1.
2.
3.

Choose Format > AutoFormat.

In the AutoFormat dialog box, click the Options button.

In the dialog box that appears, clear most of the check boxes in the Apply

and Replace areas.

You can leave the smart quote and hyperlink options selected.

Setting the margins

Setting the margins and applying the page borders enables you to see how much
content you’ve written (as long as you’ve also applied the styles to the chapter
elements). To set the margins and page borders, you just click a couple of buttons:

3 In Word for Windows: Select the Macro/Icons tab and then click the Margin

Set macro button. Then click the Page Borders macro button.

3 In Word for Mac: In the Dummies Styles pane that appears after you apply

the template, select the Dummies Margin Set macro button. Then click the
Page Borders button.

CHAPTER 1 Kickstarting the Editorial Process
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Getting started with template styles

Most of the template styles are paragraph styles. To apply a style, place your cur-
sor in the paragraph or select the whole paragraph. Then click the macro button
for the style you want to apply.

Here are a few general tips for applying template styles:

3 To apply a style to multiple paragraphs, select the paragraphs (such as
every item in a bulleted list) and then click a style macro button (such as BL).

3 To see what style is applied to a paragraph, display the style pane in
Word's Draft view. You reveal the Style Pane as follows:

1. Choose File=> Options.
The Word Options dialog box appears.
2. Click Advanced on the left.
3. On the Advanced pane, scroll down to the Display section.

4. Next to the option labeled Style Area Pane Width in Draft and Outline views, type
a measurement.

0.5"is a good start.
5. Click OK.

LOCATING STYLES IN THE WORD TEMPLATE

With the templates designed for Word 2007 and 2010, which work with Microsoft Word
365, you can access the Normal text, Production Directive, Editor Query, and heading
styles from almost any tab. Here's a list of which tabs contain other common styles:

® *Macros/Icons* includes Margin Set and icon buttons.

® *QOpeners* includes chapter numbers and titles, introductory bullets, and Parts
Pages styles.

® *Art* includes Figure and Caption styles.
® *List* includes styles for bulleted, numbered, and unnumbered lists.
® *Code* includes various Code styles.

® *SB/TB* includes sidebar and table styles.
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